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STATA is a flexible statistical package that provides important tools for data 

analysis. You can work in STATA in two ways, either using the menus of the 

toolbar or typing the commands. Most of the time, typing the commands is easier 

and faster. Once you start working out through the commands you will get a basic 

knowledge of the package. 
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1. Starting STATA and Structure 

 

- To start STATA: Select STATA from the Windows Start menu. 

- To exit STATA: select File/Exit from the STATA‟s menus: exit 

 

 

STATA Windows: 

 

Upon opening STATA, you will see four different windows in the screen of your 

computer as it is shown below: the main screen or results window, the review 

window, the variable lists window and the command window. Please notice the do 

file Editor is an extra-window that need to be opened manually as it will be shown 

later. 

 

 

 

 

 
 

 

 

 

 

 

Command Window 

 

 
 

STATA commands are entered in the command window. It supports text editing: 

copying, pasting, a command history with page up (backward command history), 

page down (forward command history). 

Results Window 

Review Window: 

Past Commands 

Do-file Editor:   

To be opened manually:  

Editor text to place  

many commands 

Command Window: 

 Type commands here 

Variable Window: 

List of Variables in the 

dataset 
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Review Window 

 

 
 

This shows the history of commands that have been entered. It is possible to copy a 

past command if you click once to the past commands. If you want to execute them 

you can double click them. 

 

Variables Window 

 

 
 

Shows the list of variables contained in the dataset. When you select a variable (by 

clicking once), the name of it appear into the command window. 

 

Viewer Window (using the help viewer as an example) 

 

The viewer window is not shown when STATA opens it is normally used to view 

help documents. It also allows you to print logs (saved results), add new commands 

from internet or install official updates to STATA. You can see it following the 

Menu Window->Viewer->New Viewer or you can select it through the STATA 

toolbar. 
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Do-file Editor 

 

 
 

A do-file is a text file that is used to type and save all the commands you want to 

execute in STATA. You will be able to reproduce your work later without having to 

type each command again (by using the command window you will be unable to 

replicate your work later on). You are recommended to start learning to use the 

do file editor immediately 
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STATA 11 Toolbar 

You don‟t need to memorize the tool bar icons. You can easily pass slowly your 

mouse through each icon and the name of each of them will appear. 

 

 
 

 

 

 

 

 

 

open:   to open a dataset in STATA version (.dta extension)  

save:   to save a dataset.  

print:   to print the contents of the window you have open.  

log:  to start, stop, pause or resume a log file.  

viewer: to open a viewer window or to bring it into the front (i.e. graphs 

window or help window that has been already opened) 

results: to open the results window, or bring it to the front.  

graph:  to open the graph window, or bring it to the front.  

do-file editor: to open the do-file editor, or bring it to the front.  

data editor:  to open the data editor, or bring it to the front.  

data browser: to open the data browser, or bring it to the front.  

more:  to continue with the outpout when long results are paused in the 

screen.  

break:  to interrupt the current task, ignoring the command was being 

executed.  

 

 

Going further with more STATA tools 

Using the Data Browser and the Data Editor. 

 

Data Browser 

 

 
 

Stata allows you to have an overview of the data in spreadsheet form without 

modifying the information. In addition to the tool bar menu you can also access to 

the spreadsheet by typing browse or br. Browsing data is very useful when you are 

creating variables and want to check how they have been allocated across the 

different observations. 

 Open      Print            Graph               More (continue) 

            Save Viewer             Do-file    Data  

         Editor Browser 

     

         Log File         Data Editor 

Break 
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Data Editor 

 

 
 

The Editor also presents the data in spreadsheet form but also allows the data to be 

edited.  

 

Header Bar 

 

 
 

At the top of the screen you can find the following menus: File, Edit, Graphics, 

Statistics, User, Window, and Help. In all of them the functions and commands 

available in STATA are included.  All the commands you execute using the menus 

also can be done by typing them manually in the command window or the do-file 

Editor. 
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Help 

 

 
 

You can see the help table of contents (going through help from the menu bar and 

then contents) or you can search for help entries on a topic.  

 

Alternatively you can use the help typing the command: to have more information 

about a command when you already know its name, type help command-name; for 

particular topics you can type help contents topic. 

 

If you want to know the kind of commands and functions available in STATA to 

conduct linear regression you can type help contents regression. 

 

If you want to know how the command regress works, type help regress to see the 

following help page: 
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2. Creating a Do-file 

 

 
 

You are strongly recommended to store your commands in a do file. This allows 

you to replicate your work later, or recreate datasets. You just need to click Do-file 

Editor in the tool bar and save it with a name of your preference. 

 

 

3. Setting Memory Parameters 

 

STATA starts with a default memory of 1MB which could be enough for small 

datasets. However, for large datasets you will need to allocate additional to hold all 

the data you need. To do so type set mem and the corresponding amount of 

memory you would like to allocate (see below).  STATA also counts with additional 

commands to increase the number of variables allowed, matrices and observations: 
 

set mem 100m  set memory to 100 megabytes 

set maxvar 5000  set maximum number of variables to 5000 

set matsize 500  allows 600 explanatory variables 

set obs 100   set number of current observations to 100 

 

Clearing any information or data previously opened (by using clear) and 

allocating the memory (set mem) are the first things you need to do before opening 

a dataset: 
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4. Entering/Opening Data 

 

Before opening a dataset you need to identify the extension of the file containing the 

information.  While many datasets are already in STATA format (i.e. the filename 

ends in .dta) many others may be available in spreadsheet format, text or comma 

separated values. It is important to be aware of this to use the appropriate command 

to open the dataset. For short datasets you can also entering the data by hand. 

 

4.1 Datasets in STATA format: ending in .dta 

 

Use the command open from the file menu and search for your dataset location. 

 

 
 

Alternatively, type the command use and the name of the dataset into the command 

window or into the do-file editor:  

 
use C:\mydata.dta 

 

 
 

You may also consider typing the command for opening the dataset by adding the 

option clear as follows to discard any other dataset that may be opened 

 
use C:\mydata.dta, clear 
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4.2 Datasets in other formats: ending in xls, txt, csv, raw 

 

The command insheet using open a dataset created in a spreadsheet (in the 

case of excel files it opens the first sheet). This command also can read files 

determined by commas or tab characters. If the file contains spaces, put double 

quotes around the filename. 

 

You can also open datasets by clicking on File >Import>, selecting the relevant data, 

and browsing to the dataset in your computer: 

 

 
 

Alternatively you can type the command by hand and the name of the dataset as 

follows, which could be in some cases easy to understand:  

 
insheet using C:\mydata.csv  To open a command 

delimited file. You can 

save the excel files as 

“comma separated values”, 

i.e. as a file ending 

with .csv 

 

insheet using C:\mydata.txt delimiter (“;”) To open a text file where  

data points are separated 

by semicolons 
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insheet using C:\mydata.raw  To open the file using the 

default extension. 

 
 

  

infile  

To open a dataset where the data is separated by spaces and are numerical values.  

For instance to input three variables named a, b, c respectively you may type: 

 
infile a b c using mydata  .raw is the default extension. 

 

 
 

Additional useful commands to start working with STATA 

 

cd C:\  to change the directory to the C:\ drive. Once 

specified the default path you just need to 

write down the name of the data set (notice 

that to open the dataset you do not need to 

specify the directory again since by executing 

Example 2: 

The following file mycars2.raw contains the 

following lines that correspond to the variables 

make, price and MPG of a few cars. The variables 

names are not contained in the files and the first 

line is formatted different to the other lines. 

Notice also that the value for price is absent for 

Chev.Monza. 

 

  “Olds 98”  8814 21 4060 

  “Chev.Monza” 3667 . 2750 

  “Datsun”  510  

5079 

24 

 

Now to upload the data: 

 

infile str18 make price mpg using mycars2 

save mycars2.dta 

 

Example 1: 

The following file mycars.raw contains the following 

lines that correspond to the variables make, price 

and MPG of a few cars. The variables names are not 

contained in the files but they are separated by 

commas. 

 

  Olds 98,8814,21,4060 

  Chev.Monza, 3667, ,2750, 

  Datsun 510,5079,24 

 

Now, to read the data: 

 

  cd C:\ 

  insheet using mycars 
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previously the command cd C:\ you have 

already done it):  use mydata.dta  

 

clear     to drop all the dataset in memory. 

exit     to exit STATA. 

save c:\mydata.dta  to save the dataset “mydata” 

save c:\mydata.dta, replace to save the dataset “mydata”, replacing the old 

version with the new one. 

 

4.3 Entering data manually 

 

First, open the Data Editor. Click on the data editor button or typing edit into the 

command window. Then, enter the data: columns correspond to variables and rows 

to observations. Use the tab key to move from one cell to the next one. Use the enter 

key to move between values in the same column. 

 

STATA 11 adds a period („.‟) in the cells without data given that you have added in 

the previous rows some data:  

 

 
 

To rename the variable, double click the column and when the Variable Properties 

dialog appears type the new variable name and click OK. You can also use copy 

and paste to change the order of the columns or rows. 
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4.4 Copying and Pasting from and Spreadsheet files 

 

For short datasets available in spreadsheet formats such as excel files, you can also 

copy the data and pasting into the data editor (by using copy/paste). However, you 

must be very careful when doing this since in some cases the data format, decimals 

or thousands are changed once you paste them into the editor leading to errors in 

your dataset. To guarantee a correct loading of your data it is better to use the 

command insheet using or you can also convert your datasets into STATA 

format by using additional software like StatTransfer
1
 

 
 

5. Command Syntax 

 

Most of the commands follow the same syntax: the name of the command, the list 

of variables to work with the command and optional arguments after a semicolon. 

 
command [variables names] [, options] 

 

In STATA help arguments that are part of the syntax are written in italics while 

optional arguments (that may not be needed to be typed are in [brackets].  

 

By understanding the syntax you can take advantage not only of all the different 

options and functions that can be executed with a particular command but also to 

understand the help window when searching for new ones. 

 
 

                                                 
1
 http://www.stattransfer.com/ 

http://www.stattransfer.com/
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In the above example, browse replaces the word command in the syntax and year 

corresponds to the [varlist] statement that followed it. As you can see you do not 

need to type brackets when writing the name of the variable. 

 

Notice also that [varlist] is in brackets which mean that for this command in 

particular, typing the name of a variable is optional and without doing it, the 

command still works which is not always the case. Thus, by typing browse without 

specifying the variable, the command will be executed over the whole dataset, 

showing all the information in spreadsheet form: 
 

The data can be also restricted by specifying a logical condition that is true or false. 

This can be made using if and some operators (=, <, >, >=, <=; negation:!=, ~). We 

can also restrict the dataset by specifying the rank of the observations using in (e.g. 

in 1/5: the first five observations of the data). The following syntax will include 

such restrictions: 

 
command [varlist] [if] [in] [, options] 

 

if is a very useful function to restrict variables over a particular population or 

restrict commands to be executed only if certain conditions applied. In addition, it is 

a command that is also allowed by most of the commands. 

 

STATA identify the first three letters of the name of the variable, then, the 

commands can be abbreviated writing down the first three letters of the command 

name followed by the name of the variable.  

 

Thus, in the example above where the variable year is viewed in spreadsheet form, 

it would be enough by typing:  

 
br year 

 

STATA commands and variable names are case sensitive. Then, if I have a variable 

called Year is not the same as having year. 

 
 

6. Starting with the Data  

 

6.1 Listing, Browsing and Editing Data 

 

Listing 
list   list the whole dataset in the Result Window.  

l   The abbreviate command for list 

Example 3: 

The syntax for the command browse is the following. 

 

browse [varlist] [if] [in] [, nolabel] 

 

and you type the following: 

 

browse year 
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list varname list one or more variables in the Result Window 

 

 
 

 
 

Browsing and Editing 

The commands browse and edit are useful commands that can be typed to list the 

information contained into the dataset, for that reason they are briefly described 

once again as follows: 
 

Example 5: 

You want to list the first 3 observations of the 

data set as we show here:  

 

list in 1/3. 

  
 

 
 

 

Example 4: 

You may want to list just the variables starting 

with m, then you use the command and then indicates 

the variable name as m* which implies all the 

variables starting with m. 

 

list m* 
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browse shows you the dataset in spreadsheet format without options to 

modify the original data. 

 

browse  varname You can browse the whole dataset or you can specify the variables 

you wish to browse.  

 

edit shows you the dataset in an excel type sheet with the possibility to 

be modified (Data Editor). You can specify also the particular 

variable you want to modify. As it can be seen, the Data Editor has 

the option to delete variables and observations.  
 

To keep the changes click the button Preserve of the Data Editor 

Menu 

 

To cancel the changes click the button Restore of the Data Editor 

Menu 
 

6.2 Describing Data 

 

When opening a new dataset that the user may not be very familiar with, it is always 

useful to have a general idea about its contents. To do so the command describe 

gives you the number of observations, the variable names, its description (or label) 

the storage type (string, float, etc). Some of the arguments more commonly used are: 

 
describe to describe the contents of the whole dataset. The 

abbreviate version of the command is des 
 

describe varname(s)  describe only the variable(s) specified. 

 

describe using filename describe the contents of the specified dataset: 

filename.  
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The storage type is another useful argument available with the description table. It 

allows you to know whether there are some information stored as non-numerical 

(i.e. strings) which must be taken into account when thinking in using such variable 

for numerical calculations. 

 

The different types of storages used by STATA are described as follows: 

   

  float for REAL numbers (7 digits of accuracy) 

  double for REAL numbers (16 digits of accuracy) 

  byte  for INTEGERS (between -127 and 100) 

  int  for INTEGERS (between -32.767 and 32.740) 

  long  for INTEGERS (between -2.147.483.647 and 

2.147.483.620) 

  str  for characters (from 1 to 80 characters. SE version 

allows until 244)  

 

6.3 Tabulating Data 

It is also possible to produce frequency counts for the variables of the dataset.  

 

tabulate varname tabulates the values of the variable specified 

(varname) by showing the number of 

observations and its respective participation 

per case. The command abbreviation is tab 
 

Example 6: 

To describe the contents of the whole dataset called 

auto.dta  

  

des 

 

 
 

The variable label gives you the description of the 

variable, which cannot be always inferred by reading 

the name. For instance the variable called rep78 

corresponds to the record of repairs in 1978 which 

would be difficult to guess without the description 

or a good manual for the survey nerby. 
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tab1 varlist creates a one-way tabulation for each variable 

specified in the varlist. This is useful when 

you want to make one-way tabulation of 

different variables without typing the above 

command several times. 

 
  

 

Example 8: 

To tabulate one-way tables of rep78 and foreign 

without typing twice the command: 

 

tab1 rep78 foreign 

 

 

Example 7: 

In the data auto.dta you are interested in 

tabulating the variable rep78 you type in the do-

file or command window the following argument 

getting a one-way frequency table as follows: 

 

tab rep78 

 

 



EC831 Final Year Project 2010 
 

tabulate varname1 varname2 shows a cross tabulation between two 

variables (varname1 varname2). 
 

 
 

 
 

 

Example 9: 

You are interested in seeing how the repairs vary 

per type of car (i.e. whether the car is domestic or 

foreign), to do so you can type the following: 

 

tab rep78 foreign 
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tabulate varname,nolabel tabulates the values of the variable specified 

(varname) in the same way described before, and 

when entries have been assigned a label the option 

nolabel ignores it showing the number of how 

the data was originally entered. 

  

Example 10: 

Now, In addition to the above cross tabulation you 

are interested in whether the headroom changes by 

the origin of the car (i.e the foreign variable) or 

whether it changes by the number of repairs. To do 

it is possible to type tab2 

 

tab2 rep78 foreign headroom 
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tabulate varname, missing tabulates the values of the variable (varname), 

shows the number of observations per case and 

with the option missing shows the missing 

values (.), if any. 

 

  
 

 

tabulate varname if tabulates the value of the variable (varname)  that 

has been restricted by one condition and shows the 

number of observations per case. 

 

Example 12: 

You are interested to know how many observations in 

your dataset are missing (as follows, sometimes the 

missing information is represented with a period 

“.”): 

 

tab rep78, missing 

 

 
 

 

 
 

 

Example 11: 

To see which values have been assigned to each entry 

of the foreign variable you can type the following: 

  

 tab foreign 

 tab foreign, nolabel 

 

 
 

 

 
 

 



EC831 Final Year Project 2010 
 

 
  

 
tabulate varname1 varname2, col row  when using the two-ways 

tabulation, the options col and row indicates percentages by column and by rows including 

missing as an extra value for the variable. 

 

 
 
 

Example 14: 

You are interested in the distribution of cars by 

origin (i.e. domestic or foreign) per each of the 

reparation records  

 

tab rep78 foreign, col row 

 

 
 

 
 

 

Example 13: 

You are interested in tabulating those cases that 

have 3 or less repairs 

 

tab rep78 if rep78<=3 
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6.4 Descriptive Statistics 

In addition to the general contents of the dataset provided by the command 

describe, the descriptive statistics are an important tool that helps to know better 

the data. In STATA the descriptive statistics are produced by the command 

summarise. It shows the number of observations, the mean, the standard 

deviation, the minimum and the maximum value of the variables.  

 

summarise   summarise the numerical values of all the variables 

in the dataset. The command abbreviation is sum 

 

 
 

  

summarise varname(s)  summarise the numerical values of one or more 

variables (varnames) in the dataset. It shows the 

number of observations, the mean, the standard 

deviation, the minimum and the maximum value of 

the variables. 

 

Example 15: 

You are interested in the mean, minimum and maximum 

values per variable: 

 

sum 

 

 
 

Notice that in the example the variable make appears 

as it would have 0 observations. Actually it has 

observations (you can check this by tabulating the 

variable) but the variable has been stored as a 

string variable or non numerical variable which in 

this case correspond to the name of the car maker 

which cannot be averaged in text format. 
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summarise varname(s) if summarise the numerical values of one or 

more variables (varnames) in the dataset 

given the condition imposed by the argument 

if. It shows the number of observations, the 

mean, the standard deviation, the minimum 

and the maximum value of the variables. 

 

 
 

  

6.5 Creating and Manipulating Variables 

 

Generating New Variables 

To create new variables STATA counts with the generate command. It allows the 

user to generate new variables that could be a mathematical combination or a 

particular condition of the existing ones. 

 

generate newvar=exp creates a new variable (newvar) equal to any valid 

expression (exp). The expression could be an 

algebraic expression of other variables or just a 

numerical value. The command may be abbreviated 

typing gen, ge or just g. 

Example 17: 

You are interested in the descriptive statistics for 

the repairs record in cases with less than 3 

repairs: 

 

 sum rep78 if rep78<=3 

 

 
 

 
 

 

Example 16: 

You are interested in the descriptive statistics for 

the repairs record and for the foreign variable: 

 

 sum rep78 foreign 
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replace varname=exp changes the contents of an existing variable (varname). 

The command cannot be abbreviated.  
 

 
 

 

egen newvar=fnc(arg) creates variables that are more difficult to compute. 

egen is more powerful than gen. For instance, you 

would be interested in create a new variable that is the 

mean of the other or a new variable that count the 

number of observations, etc. Thus, in the command 

syntax fnc correspond to the function you want to 

Example 19:  

You want to create a dummy variable indicating 

whether the car has three or less repairs (i.e. a 

variable taking the value of one if the condition of 

less than three repairs holds, zero otherwise) 

 

There are different ways to create dummy variables 

in STATA we shows two of them: 

 

gen dummyrepairs3=1 if rep78<3 

replace dummyrepairs3=0 if dummyrepairs3!=1 

 

Alternatively you can type: 

 

gen dummyrepairs3=(rep78<3) 

 

Notice that not always is possible to use the short 

version of the argument since you may have different 

conditions when allocating the ones and the zeros in 

a new variable. In fact, in some cases the entries 

with zero would not necessarily correspond to 

everything else after the one has been assigned. 

 
 

 
 

 

Example 18: 

You can create new variables containing the values 

of one and two respectively and a new variable equal 

for the sum of both of them:  

 

gen x=1 

gen y=2 

gen xy= x + y 

 

The variable with ones has been named x, while y 

will correspond to the variable with twos and the 

variable with the name xy is the sum of both of 

them: 

 

You can also create a variable with values only for 

those having less than three repairs: 

 

gen repairs3 = rep78 if rep78<3 
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execute: mean, count, min, total, sd, median, etc. arg 

correspond to the variables or numbers you need to 

generate the new variable. 
  

 
 

 

rename oldvar newvar change the name of an existing variable. 
 

 
 

 

  

Deleting and Keeping Variables 
 

drop varname(s)  eliminates the variable(s) specified from the memory. 

drop _all   eliminates the data set from memory.  

 

keep varname(s) keep the variables you specified eliminating the other 

ones. 

 

6.6 Labeling variables 
 

label var  sets or changes the variable‟s label. The label should be in 

double quotes. 
 

 
 

  

label define  creates a value label (it gives a label to the possible values of 

the variable) : 
 

Example 22: 

Labeling a variable created as the average of an 

existent variable: 

 

label var meanrep78 “Average Repairs” 

 

 
 

 

Example 21:  

Changing the name of sumrep78 by totalrepairs 

 

ren sumrep78 totalrepairs 

 

 
 

 

Example 20:  

Generating a new variable that is the average of the 

repairs records in the dataset 

  

egen meanrep78=mean(rep78) 

 

Now, you are interested in generating a new variable 

that is the total of the repairs records in the 

dataset 

 

egen sumrep78=sum(rep78) 
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label values  associates the value label we created before with the variable. 
 

 

 

 

6.7 Working with String Variables 

 

String Variables are variables that could be letters or special characters. Sometimes 

STATA stores numeric values as strings; this the main source of a “type 

mismatch” error. Then, we would like to convert this variable into a number or 

viceversa. The following list of commands will help with that: 

 

destring varname, replace  converts the string variable varname 

into a numeric variable.  
 

gen varname=real(string_num) converts the string values into numeric 

values. 

 

encode varname,gen(newvar) convert a string variable into a numeric 

variable (using the character values as 

labels. 

 

decode varname,gen(newvar) convert a number into string (numeric 

values must have value labels assigned 

to use them as the new string values for 

the variable). 

 

gen varname=string(var_num)  converts numeric values into string. 

 

generate newvar=“stringvar” generates a string variable (notice that 

the expression is enclosed by double 

quotes). 

 

 

 

 

Example 24: 

Allocating the ones and zero definitions stored in 

valuesdummyrepairs2 into a variable called repairs3 

which contains the value of one for those 

observations with less than 3 repairs and zero for 

the remind cases. 

 

label values repairs3 valuesdummyrepairs3 

 
 

 

Example 23: 

Defining the ones and zeros in a dummy variable: 

 

label define valuesdummyrepairs3 1 “Less than 3 

repairs 0 ”Otherwise” 
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6.8 Graphs 

 

You can use the graph button or the graph command to make a graph of your data. 

The graph button from the menu brings the topmost graph window.  
 

Histogram 

 
 

 

If you already know the kind of graph you need you can write down one of the 

following graph commands: 

 

histogram varname        histogram of the variable varname 

 

graph twoway              scatterplots, line plots, etc. 
 

scatter varname1 varname2     scatterplots, line plots, etc. 
 

twoway scatter              scatterplots. 
 

graph matrix             scatter plot matrices. 
 

graph bar                bar charts. 

 

graph dot                dot charts. 
 

graph box                box-and-whisker plots. 
 

graph pie                pie charts. 

 

 

Graph Buttons: 

The important ones: 

 

          Save the graph 

 

          Print the graph 

Graph Window 
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Example 26: 

To draw a histogram of the repairs record in 1978 

and to add a title to the graph: 

 

hist rep78, title(Repairs Record 1978) 

 

  
 
 

Example 25: 

To graph a scatterplot you type the command followed 

by the y-variable and x-variable as follows: 

 

graph twoway scatter weight length 
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Saving Graphs 

To save the graph you can use the save button on the Graph Window or right click 

on the graph window and select Save Graph or select the File>Save from the 

Graph Window. 

 

Printing Graphs 

To print the graph you can use the save button on the Print Window, or right click 

on the graph window and select Print Graph or select the File>Print from the 

Graph Window. 

 

 

7. Joining two different datasets 

 

To join two different data sets we can use the commands append and merge. 

 

7.1 Appending Data 

Sometimes you would like to add observations to an existing dataset: additional 

respondents, additional years, etc. Since such information could come from a 

different dataset then you would want to join both datasets. The command append 

does this. 

 
append combine two datasets vertically adding more observations to the end of the first 

dataset opened (master data). It is not necessarily that both datasets have the same variables. 

 

Example 27: 

To draw a time line for the life expectancy of a 

country and adding the respective title:  

 

twoway (line le year),title(Life Expectancy 

(Annual)) 

 

 
 
where le and year are the y-variable and x-variable 

respectively 
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Example 28: 

You have two separate datasets with information 

about domestic (domestic.dta) and foreign 

(foreign.dta) cars respectively. Each dataset 

contains the same variables: height, weight, maker, 

etc: 

 

 
 

You can pool the information in one dataset by 

adding the information of the second dataset 

literally “below” the first dataset: 

 

use domestic.dta 

append using foreign.dta 
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7.2 Merging Data 

Sometimes we need to add more variables to an existing dataset. Suppose for 

instance you have a State‟s census separated in different datasets, i.e in a first 

dataset you have the number of inhabitants while in a second dataset you have the 

marital status information: 

 
census1.dta            census2.dta 

  
 

You can join both datasets to increase the amount of information for the same 

observations, in the case above, for the same states. To do this the command merge 

is needed.  

 

STATA 11 has easy the procedure of merging datasets with new arguments for 

merge. Although is more precise, the old fashion way of merging could help to 

understand what STATA is doing when merging datasets. The following examples 

consider the two ways of merging the above datasets. 

 

 
 

After merging both datasets, the new dataset looks like the following: 

Example 29: 

Merging in Stata11 

 

merge 1:1 varlist using filename 

 

Merging one to one the observations from both 

datasets using a key variable (a unique identifier 

available in both datasets), in this we have an 

state’ id: 

 

use census1.dta, clear 

merge 1:1 stateid using census2.dta 
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STATA 11 generates a variable called _merge which summarises the merging 

procedure as it is shown below. Notice that the master data corresponds to the 

dataset currently in memory, using data corresponds to the dataset you are merging 

with. In the example above, census1.dta corresponds to the master data while 

census2.dta corresponds to the using data. 

 

_merge =  1 master         originally appeared in master dataset only:  

It refers to the number of observations from 

the master data that didn‟t match with the 

using data.  

 

_merge =  2 using           originally appeared in using dataset only:  

It refers to the number of observations from 

the using data that didn‟t match with the 

master data.                             

 

_merge =  3 match           originally appeared in both datasets:  

It refers to the number of observations from 

the master data that matched with the 

observations in the using data. 
 

It may be the case that some datasets present the information in the following way: 

one dataset for individual information about the patients in a hospital and a separate 

dataset with information about the characteristics of the hospital as it is shown 

below:   
 
patients_info.dta 
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hospitals_info.dta 

 

 
 

You can add the characteristics of the hospital to the patients thanks to the fact that 

both datasets share one identifier: the hospital code. This is called in STATA many 

to one or one-to many merge as it will be shown in the examples below: 

 

 
 

 
 

Notice that in both examples the final output only differs in the way the variables 

are organised. In the one-to-many merging procedure, the information from the 

hospital data (which contain one observation per hospital) is presented first in the 

new dataset, while in the many-to-one merge the hospital‟ patients (many 

observations per hospital) are the first variables in the dataset. 

 

It is useful to delete the _merge variable created by STATA to avoid error 

messages in the future when you want to conduct new merges. 

Example 31: 

Merging many-to-one 

 

use patients_info.dta, clear 

merge m:1 using hospitals_info.dta 

save patients_hospitals.dta 

 

After browsing the new dataset, it will looks like: 

 

 

Example 30: 

Merging one-to-many 

 

use hospitals_info.dta, clear 

merge 1:m using patients_info.dta 

save patients_hospitals.dta 

 

After browsing the new dataset, it will looks like: 
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For instance, the arguments for the above example would be the following in 

versions before 11: 
 

use hospitals_info.dta, clear 

sort hospital_id 

save, replace 

 

use patients_info.dta, clear 

sort hospital_id 

save, replace 

 

use hospitals_info.dta, clear 

merge hospital_id using patients_info.dta 

tab _merge 

drop _merge 

save patients_hospital.dta 

 

Summarizing the steps to conduct merging with previous versions to STATA 11:  

 

Step 1: sort the key variable or identifier in both datasets. 

 

Step 2: open the dataset you want to be the “master data” followed by the 

merge command.  

 

Step 3: Tabulate the variable _merge to have information about the merging 

procedure and drop it afterwards. 

 

Step 4: Save with the new dataset. 
 

 

8. Saving Output 

 

Logs 

Logs are files that store the results of your analysis such as summary statistics, 

variables frequencies, etc. The logs can be viewed using the viewer and can be 

easily printed. To start and finish the log you should type log using and log 

close respectively. You can also suspend the storage of some results by typing 

log off and to restart the storage again you type log on. 

 

 
 

 

Example 32: 

 

log using census.txt 

sum 

log off 

 

gen gend=(e03==1) 

 

 

log on 

reg wage gend 

log close 
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9. Basic Econometric Analysis 

 

To run a linear regression between a dependent variable and the independent 

variables use the command regress (abbreviated with reg) with the following 

syntax: 

 
regress depvar indvar(s)  

 

The variable after the command regress is the dependent variable or the variable 

you want to explain. The variables written after that variable are those that you will 

use to explain the first one (independent variables) . 
 

 
  

predict newvarname create a variable with the values predicted by the 

model after the regression was run (it must be 

executed after the estimation command, e.g. regress). 
 

 
 

If your dependent variable is binary (i.e. 0 or 1), then you will have to use 

alternative models that require different commands such as logit and probit. 

Example 34: 

Calculating the fitted values for the dependent 

variable in a new variable called pricehat: 

 

reg price weight length foreign 

predict pricehat, xb 

 

Example 33: 

To run an OLS regression where car’s price is 

explained by its weight, length, origin and a 

constant you type the following: 

 

reg price weight length foreign 

 

 
 

To exclude the constant, you can add the following 

the option noconstant as follows: 

 

reg price weight length foreign, noconstant 
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Presenting regression results 

The regression output that STATA shows by default is not the most attractive way 

to present the results in a document. However, there are a series of commands that 

make possible to convert STATA‟ regression results into a standard table. 

 

estimates store name  save the results of the current 

estimation with the name you specified 

(the abreviation is eststo).  

 

estimates table name tabulates the results saved under the 

specified name (the abbreviation is 

esttab). 
 

esttab name using filename.rtf  tabulates the results saved under the 

specified name and export them into a 

file rtf format, readable in text 

processors such as Word. 

 

 
 

 

 

Example 35: 

Tabulating the results of two different regressions, 

the first one including the constant and the second 

one excluding it. In addition to this you would like 

to present the standard errors (se) rather than the 

t-statistic (default) and you would like to name 

your table “Table 1: Regression Results”, then you 

follow the next arguments: 

 

reg price weight length foreign 

estimates store Reg1 

 

reg price weight length foreign, noconstant 

estimates store Reg2 

 

esttab Reg1 Reg2 using OLS_Results.rtf, se 

title("Regression Results")  

 

The following table is produced in rtf file: 

 
Table 1: Regression Results 

 (1) (2) 

 price price 

weight 5.775*** 4.868*** 

 (0.959) (0.658) 

   
length -91.37** -51.51*** 

 (32.83) (11.33) 

   
foreign 3573.1*** 3792.4*** 

 (639.3) (619.3) 

   
_cons 4838.0  

 (3742.0)  

N 74 74 

Standard errors in parentheses 
* p < 0.05, ** p < 0.01, *** p < 0.001 
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10. Starting with Time Series 

 

First, we need to specify that we are working with time series data and the date 

variable that tells STATA the date format (day, quarter, year, etc.). To do that we 

type: 

 
tsset datevar 

 

where datevar is the name of the date variable in your dataset. After that you can 

continue performing the statistical analysis using the additional commands available 

to deal with time series. 

 

 
 

Inputting Time Series Dates 

When we have the date component in separated variables, we would like to combine 

them by creating a new date variable. To do that we can use the command gen again 

and the following expressions: 

 

mdy(month,day,year)  for daily data  

yw(year, week)   for weekly data  

ym(year,month)   for monthly data  

yq(year,quarter)   for quarterly data  

yh(year,half-year) for half yearly data 

 

For instance, you have two variables, month and year. You can combine them in 

order to have one date variable by typing: 

 
gen month=ym(year,month) 

 

 

 

Example 36: 

Defining the time variable for the following 

dataset: 

 

 
 

tsset date 
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11. Summary 
 

Useful Commands, recalling the command syntax: 
 

command [varlist] [if] [in] [, options] 

 
Command Name Abreviation Function Example 

Starting...       

clear clear Clear Memory (closes any other dataset  

previously opened) 

clear 

set memory set mem Change amount of memory allocated to Stata set mem 100m 

set maxvar  set maxvar Set maximum number of variables in  
Stata/MP and Stata/SE 

set maxvar 2000 

cd:\   Change directory cd "C:\MyDocuments\MyProject 

  
 

 

Opening Datasets       

use  use Open a Stata-format dataset (ending .dta) use mydata.dta, clear 

insheet insheet Read ASCII (text) data created by a spreadsheet insheet using mydata.csv 

infile infile 
Read unformatted ASCII (text) data 

infile str18 make price mpg rep78 

   
 

  

Saving Datasets  
 

  

save save Save data in memory to file save mydata.dta 

save, replace save, replace Overwrite existing dataset save mydata.dta, replace 

Exit Stata  
 

  

exit exit Exit Stata exit 

  
 

 

  
 

 

Describing and 

Listing the Data 

  
  

  

describe desc Produces a summary of the dataset in memory or 

of the data stored in a Stata-format dataset 

desc 

desc price 

tabulate tab 
One-way tables of frequencies and 

Two-way tables of frequencies 

tab gender 

 

tab gender age 

tab1 tab1 
One-way tables of frequencies 

tab1 gender 

tab1 gender age 

tab2 tab2 
Two-way tables of frequencies 

tab2 gender age 

tab2 gender age education 

summarise sum Calculates and displays a variety of  
univariate summary statistics 

sum 

sum age gender 

edit edit Brings up a spreadsheet-style data editor for 

entering new data and editing existing data. 

edit 

list l 
List (displays in the screen) values of the 
variables 

list 

list in 1/10 

list age 

  
 

 

Manipulating the 

Data 

  
  

  

generate gen 
Creates a new variable.  The values of the 
variable are specified by =exp. 

gen x = 1 

gen age = year-yearborn 

gen dummy=(sex==1) 

egen egen Creates newvar of the optionally specified 

storage type equal to fcn(arguments), i.e, mean, 
sd, etc. 

egen average=mean(price) 

egen total=sum(price) 

replace replace 
Replace contents of existing variable 

gen x= 1 

replace x=2 if year==1980 

keep keep Keep variables / Observations keep age gender / keep if age<10 

drop drop Drop variables / Observations drop education / drop if age>10 

rename ren Rename variable ren years_school education 
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edit edit Brings up a spreadsheet-style data editor for 

entering new data and editing existing data. 

edit 

destring destring 

Convert string variables to numeric variables 

 and vice versa 

destring code, replace 

 

tostring code, replace 

  
 

 

Joining Datasets       

append app Appends Stata-format datasets stored on disk to 
the end of the dataset in memory 

use data1.dta 

append using data2.dta 

merge mer Merge joins corresponding observations from the 

dataset currently in memory with a second 
dataset (before Stata 11) 

use census1978.dta 

merge id using census1988.dta 

merge 1:1  
One-to-one merge on specified key variables 

use census1978.dta 

merge 1:1 id  using census1988.dta 

merge 1:m  
One-to-many merge on specified key variables 

use individuals.dta 

merge m:1 id  using families.dta 

merge m:1  
Many-to-one merge on specified key variables 

use families.dta 

merge 1:m id using individuals.dta 

sort   Sort data sort 

  
 

 

Basic Regression 

Analysis 

  

  
  

regress reg Fits a model of depvar on indepvars using linear 

regression. 

reg price weight length type 

   
 

  

estimates store eststo Store and restore estimation results   

estimates table esttab 
Displays a table of coefficients and statistics for 
one or more sets of estimation results 

reg price weight length type 

eststo Reg1 

esttab Reg1 using Results.rtf 

   
 

  

tsset tsset Declare data to be time-series data tsset year 

  
 

 

Additional 

Operators 

 

 

 

if if 

if at the end of a command means the command 

is to use only the data specified. if is allowed 

with most Stata commands. 

reg price weight length type if 

foreign==1 

 

sum weight if price<5000 

 

tab age if age>16 

Basic Operators   

  

Arithmetic              Logical            (numeric and string) 

--------------------     ------------------     --------------------- 
    +   addition                &   and               >   greater than 

     -   subtraction             |   or                <   less than 
     *   multiplication          !   not               >=  > or equal 

     /   division                ~   not               <=  < or equal 

     ^   power                                                ==  equal 
     -   negation                                             !=  not equal 

     +   string concatenation                       ~=  not equal 
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12. Useful sources for STATA Support 

 

STATA website: 
http://www.stata.com/support/ 

http://www.stata.com/links/resources1.html  

 

UCLA STATA Reference Website: 

http://statcomp.ats.ucla.edu/stata/ 
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